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Bienvenido a  
John Deere Precision Ag 
 
Está en camino de lograr una actividad agrícola aún más inteligente, 
impulsada por datos y conexiones poderosas. ¡Estamos a su disposición 
para ayudar! 
Esta guía lo orientará a través de tareas específicas, en el John Deere 
Operations Center™ y en la cabina, para aprovechar al máximo la 
tecnología Precision Ag.
CONFIGURAR: configure y administre toda su granja, incluidos el 
equipamiento, los campos, los productos y el equipo.
PLANIFICAR: simplifique la configuración en cabina y mejore la 
precisión de los datos planificando el trabajo antes de que los operarios 
empiecen el trabajo de campo.
EN LA CABINA: configure la pantalla en la cabina para garantizar una 
recopilación de datos limpia y precisa.
MONITOREAR: mantenga un control de sus campos y equipos para 
garantizar que se realice el trabajo correcto en el momento adecuado, 
con lo que ayuda a los operarios a minimizar los errores.
ANALIZAR: evalúe sus resultados una vez que haya terminado el trabajo 
y use datos precisos para determinar qué funcionó mejor a medida que 
planifica la próxima temporada.

Este folleto impreso está actualizado a la fecha 
de su publicación, pero Precision Ag está en 
constante evolución y mejora. Para ver la copia 
digital más actualizada de este folleto, escanee 
este código QR:
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Prepárese para la próxima temporada. Las siguientes listas 
de verificación lo ayudarán a prepararse para la temporada de 
cultivo. Al llevar a cabo cada una de estas acciones se asegurará 
de que su explotación esté preparada para aprovechar al máximo 
la tecnología disponible.

La máquina debe tener conectado un módem.
Utilice transferencia a través de USB para máquinas que 
no estén conectadas.
Debe tener una licencia activa de Automation 4.0 o G5 
Advanced para su máquina.
Debe tener una licencia Command Center™ Premium 3.0 
o G 5 Advanced activa para su máquina.

LISTAS DE 
VERIFICACIÓN

∞
≠

�

±
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Lista de verificación de laboreo
TAREA PÁGINA #

En el Centro de Operaciones antes de la 
temporada:
Añada sus equipos e implementos, incluidas las 
compensaciones. 11-12

Verifique que se hayan creado todos los campos 
que trabajará esta temporada. 13

Verifique la existencia de límites y cabeceras para 
todos los campos. 14-15

Verifique la existencia de pistas guía para todos los 
campos. 16

Agregue fertilizantes a los productos. 18

Verifique que se han agregado todos los miembros 
del equipo con los permisos adecuados. 21-25

Elabore planes de trabajo de laboreo para todos los 
campos. 31

Envíe planes de trabajo a su equipo ∞ o expórtelos 
a un USB ≠. 33-34

En la cabina:

Configure la pantalla. 37

Configure la maquina y los implementos. 47

Configure la Automatización de giros AutoTrac™. 50

Configure AutoPath™ (filas) �. 54

Configure la Guía de implementos AutoTrac™ �. 57

Configure el intercambio de datos en el campo si más 
de una máquina funcionará en el mismo campo. ± 64
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Lista de verificación de plantación/siembra
TAREA PÁGINA #

En el Centro de Operaciones antes de la 
temporada:
Añada sus equipos e implementos, incluidas las 
compensaciones. 11-12

Verifique que se hayan creado todos los campos 
que trabajará esta temporada. 13

Verifique la existencia de límites y cabeceras para 
todos los campos. 14-15

Verifique la existencia de pistas guía para todos los 
campos. 16

Agregue variedades de semillas, productos 
químicos o fertilizantes a los productos. 18

Verifique que se han agregado todos los miembros 
del equipo con los permisos adecuados. 21-25

Cree planes de trabajo de plantación/siembra para 
todos los campos. 31

Envíe planes de trabajo a su equipo ∞ o expórtelos 
a un USB ≠. 33-34

En la cabina:

Configure la pantalla. 37

Configure la maquina y los implementos. 47

Configure la automatización de giro AutoTrac™ �. 50

Configure AutoPath™ (filas) �. 54

Configure la Guía de implementos AutoTrac™ �, 57

Configure el intercambio de datos en el campo si más 
de una máquina funcionará en el mismo campo. ± 64
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Lista de verificación de aplicación
TAREA PÁGINA #

En el Centro de Operaciones antes de la 
temporada:
Añada sus equipos e implementos, incluidas las 
compensaciones. 11-12

Verifique que se hayan creado todos los campos 
que trabajará esta temporada. 13

Verifique la existencia de límites y cabeceras para 
todos los campos. 14-15

Verifique la existencia de pistas guía para todos los 
campos. 16

Agregue productos químicos o fertilizantes a los 
productos. 18

Agregue mezclas de tanque o mezclas secas. 19

Verifique que se han agregado todos los miembros 
del equipo con los permisos adecuados. 21-25

Elabore planes de trabajo de aplicación para todos 
los campos. 31

Envíe planes de trabajo a su equipo ∞ o expórtelos 
a un USB ≠. 33-34

En la cabina:

Configure la pantalla. 37

Configure la maquina y los implementos. 47

Configure AutoPath™ (filas). � 54

Configure el intercambio de datos en el campo si más 
de una máquina funcionará en el mismo campo ±. 64
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Lista de verificación de cosecha
TAREA PÁGINA #

En el Centro de Operaciones antes de la 
temporada:
Añada sus equipos e implementos, incluidas las 
compensaciones. 11-12

Verifique que se hayan creado todos los campos 
que trabajará esta temporada. 13

Verifique la existencia de límites y cabeceras para 
todos los campos. 14-15

Verifique la existencia de pistas guía para todos los 
campos. 16

Verifique que se han agregado todos los miembros 
del equipo con los permisos adecuados. 21-25

Cree planes de trabajo de cosecha para todos los 
campos. 31

Envíe planes de trabajo a su equipo ∞ o expórtelos 
a un USB ≠. 33-34

En la cabina:

Configure la pantalla. 37

Configure la maquina y los implementos. 47

Configure la automatización de giro AutoTrac™ �. 50

Configure AutoPath™ (filas) �. 54

Configure Machine Sync �. 59

Configure el intercambio de datos en el campo si más 
de una máquina funcionará en el mismo campo. ± 64
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Configure su organización con los equipos, los terrenos, los 
productos y las conexiones correctos para garantizar la precisión 
de los datos. Dedique tiempo de antemano a crear una base 
sólida que le permita maximizar el valor de las herramientas de 
planificación, supervisión y análisis del Centro de Operaciones.

CONFIGURAR

Todas las instrucciones de tareas se deben usar 
a través de un navegador web, a menos que se 
indique algo distinto para dispositivos móviles.
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Conoce Operations Center de John Deere

Crear una cuenta en el Centro de Operaciones

1.	 Vaya a OperationsCenter.Deere.com en su navegador web.
2.	 Haga clic en Create an Account (Crear una cuenta).
3.	 Seleccione la categoría y el enfoque que describan su 

operación.
4.	 Introduzca su nombre de usuario y su dirección de correo 

electrónico, a continuación haga clic en Submit for Email 
Verification (Enviar para verificación del correo electrónico).

5.	 Introduzca el código de verificación que se envió a su cuenta 
de correo electrónico y haga clic en Verify Email (Verificar 
correo electrónico).

6.	 Introduzca su información personal, luego haga clic en Next 
Step: Create Password (Siguiente paso: Crear contraseña).

7.	 Introduzca una contraseña, vuelva a introducir su contraseña 
para confirmarla y, a continuación, haga clic en Create 
Password.

8.	 Introduzca su nombre de organización y haga clic en Next 
(Siguiente).

9.	 Lea las condiciones generales, marque la casilla para aceptarlas 
y haga clic en Next.

10.	 Introduzca el número de serie del equipo y haga clic en Add 
Equipment (Añadir equipo) o haga clic en Add Equipment 
Later (Añadir equipo más tarde).

11.	 Seleccione su distribuidor John Deere y habilite o deshabilite 
el intercambio de datos con su distribuidor, luego haga clic en 
Complete Setup (Completar configuración).

12.	 Haga clic en Done (Listo).
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Instalacion de Terminales en Operations 
Center John Deere

Añadir equipo
Gestione máquinas, implementos y dispositivos en un solo lugar.

1.	 Haga clic en Setup > Equipment (Configuración > Equipo).
2.	 Seleccione las pestañas Machines, Implement o Devices 

(Máquinas, implementos o dispositivos).
3.	 Haga clic en +Add (+Añadir).
4.	 Introduzca el Número serial.
5.	 Introduzca el Módem (opcional).
6.	 Haga clic en Add Equipment.

NOTA: Su distribuidor puede ayudar a transferir equipos y módems a 
su organización. Se requiere un módem para habilitar la Transferencia 
inalámbrica de datos y la capacidad de Acceso remoto a la pantalla.

MÓVIL
1.	 Haga clic en Setup > Equipment > +Add (Configuración > 

Equipo > +Añadir).
2.	 Introduzca o escanee el número de serie.
3.	 Introduzca el Módem (opcional).
4.	 Haga clic en Add Equipment.
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Configuración de equipos e implementos 
de compensaciones
Asegúrese de que el trabajo esté documentado con 
precisión y que las funciones de automatización como 
AutoTrac™ estén listas para su uso.

1.	 Haga clic en Setup > Equipment.

2.	 Seleccione las Máquinas o los implementos, a 
continuación seleccione el Equipo que desea modificar.

3.	 En la ventana emergente, seleccione las Características  
y haga clic en Edit (Editar).

4.	 Modifique las características según sea necesario.
5.	 Haga clic en Save (Guardar).
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Crear un campo
Asegúrese de que los datos de la documentación se registran 
con el mismo nombre en todas las máquinas para facilitar su 
clasificación y análisis en el Centro de Operaciones.

1.	 Haga clic en Setup > Land > +Add (Configuración > Terrero > 
+Añadir).

2.	 Seleccione Field (Campo) como tipo de ubicación.
3.	 Seleccione su Cliente o haga clic en Add New Client (Añadir 

nuevo cliente).
4.	 Seleccione su granja o haga clic en Add New Farm (Añadir 

nueva granja).
5.	 Introduzca el campo.
6.	 Haga clic en Save.

Configuración de Campos en Operations Center 

MÓVIL
1.	 Haga clic en Setup > Land > +.
2.	 Introduzca el campo.
3.	 Seleccione su cliente o haga clic en Add Client.
4.	 Seleccione su granja o haga clic en Add Farm.
5.	 Seleccione su límite (opcional)
6.	 Haga clic en Save.
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Crear un límite a partir de una operación anterior
Permita una utilización más sencilla de las tecnologías  
agrícolas de precisión.

1.	 Haga clic en Setup > Land > +Add.
2.	 Seleccione Boundary (Límite) como tipo de ubicación.
3.	 Seleccione de la Operación anterior.
4.	 Seleccione el campo y, a continuación, haga clic en Next.
5.	 Introduzca un nombre de límite.
6.	 Seleccione la operación que creó el límite.
7.	 Haga clic en Save.
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Crear un límite mediante dibujo
Señale la ubicación de los campos para las comunicaciones  
del equipo.

1.	 Haga clic en Setup > Land > +Add.
2.	 Seleccione Boundary como tipo de ubicación.
3.	 Seleccione Draw new (Dibujar nuevo).
4.	 Seleccione el campo para asociar el límite, luego haga clic 

en Next.
5.	 Introduzca un nombre de límite, seleccione Boundary Status 

(Estado de límite) e Irrigation (Irrigación).
6.	 Haga clic en los botones Draw Polygon, Draw Circle o 

Draw Rectangle (Dibujar polígono, Dibujar círculo o Dibujar 
rectángulo) en la parte derecha del mapa para dibujar un 
borde alrededor de su campo.

7.	 Si es necesario, haga clic en Add Interior Shape (Añadir forma 
interior) y, a continuación, utilice las herramientas de dibujo 
para trazar los límites interiores.

8.	 Haga clic en Save.

NOTA: No es recomendable utilizar límites creados mediante dibujo 
y, en algunos casos, no se pueden utilizar para determinadas ofertas 
tecnológicas debido a requisitos de precisión.

SUGERENCIA: Consulte la sección "Crear un límite conduciendo" en la 
página 40 para obtener instrucciones detalladas sobre cómo crear un 
límite por conducción.
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Crear una pista de orientación
Mejore la eficiencia y precisión del trabajo mediante un  
mejor control del equipo.

1.	 Haga clic en Setup > Land > +Add (Configuración >  
Terreno > +Añadir).

2.	 Seleccione (Track) (Pista) como tipo de localización.
3.	 Seleccione Straight Track (Pista recta) o Circle Track (Pista 

circular).
4.	 Seleccione el campo al que está asociada la pista y luego ingrese 

el espacio entre las huellas del implemento.
5.	 Haga clic en Next.
6.	 Introduzca el nombre de la pista.
7.	 Marque la casilla Enable Snap to Boundary (Activar ajuste a límite).
8.	 Dibuje su pista en el mapa.
9.	 Haga clic en Save.

Agregar cabeceras de campo
Administre sus cabeceras fuera de borda y compártalas  
con toda la flota.

1.	 Haga clic en Setup > Land (Configuración > Terreno). 
2.	 Haga clic en la pestaña Boundaries, luego haga clic en  

Field Boundary.
En Exterior, seleccione Headland (Cabecera) y luego  

seleccione Headland Type (Tipo de cabecera) 
•  Para desplazamiento constante, introduzca Offset (Desplazamiento).  
•  �Para desplazamiento superior e inferior, introduzca Heading Angle 

(Ángulo de cabecera), Top Offset (Desplazamiento superior) y 
Bottom Offset (Desplazamiento inferior).

3.	 Haga clic en Save.

SUGERENCIA: Gracias a la gestión de cabeceras en el Centro de Operaciones, 
es fácil beneficiarse del Control de Secciones, de la Automatización de Giros 
AutoTrac™ y de AutoPath™.
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Añadir una bandera
Resalte los obstáculos en el campo y las condiciones de los 
cultivos.

1.	 Haga clic en Setup > Land > +Add.
2.	 Seleccione Flag (Bandera) como tipo de ubicación.
3.	 Seleccione Flag Type (Tipo de bandera) y Field Associated 

(Campo asociado), luego haga clic en Next.
4.	 Seleccione Flag Category (Categoría de bandera) o haga clic 

en Edit Flag Categories (Editar categorías de banderas). 
5.	 Haga clic en el mapa para soltar la bandera.
6.	 Introduzca notas (opcional).
7.	 Haga clic en Save.

MÓVIL
1.	 Haga clic en el ícono Map > Flag+ (Mapa > Bandera).
2.	 Haga clic en el mapa para soltar la bandera.
3.	 Seleccione la categoría o haga clic en +Add (Añadir) para 

crear una nueva categoría de bandera y un color de bandera 
personalizado.

4.	 Seleccione Field e ingrese notas.
5.	 Añada una foto (opcional).
6.	 Haga clic en Save.
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Añadir un producto
Gestione todos los insumos (variedades de semillas, 
fertilizantes, productos químicos) utilizados en su 
operación para obtener documentación precisa.

1.	 Haga clic en Setup > Products > +Add > Products 
(Configuración > Productos > +Añadir > Productos).

2.	 Busque el producto deseado por nombre, tipo de 
cultivo o marca.

3.	 Seleccione el producto que desea añadir.
4.	 Haga clic en Add Product (Añadir producto).

Configuración de Productos en Operations Center 
John Deere

MÓVIL
1.	 Haga clic en Setup > Products > Varieties / Chemicals / 

Fertilizers > + (Configuración > Productos > 
Variedades/Productos químicos/ Fertilizantes > +).

2.	 Introduzca el nombre del producto en la barra de 
búsqueda.

3.	 Seleccione el producto y luego haga clic en Save.
4.	 Si no se encuentra, haga clic en + Add Custom Variety / 

Chemical / Fertilizer, introduzca los detalles adicionales 
y, a continuación, haga clic en Save.
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MÓVIL
1.	 Haga clic en Setup > Products > Tank Mixes > + 

(Configuración > Productos > Mezclas de tanque > +).
2.	 Introduzca el nombre.
3.	 Seleccione los cultivos objetivo, introduzca la tasa de 

aplicación global.
4.	 Haga clic en Select Products, seleccione losproductos que va 

a incluir, luego haga clic en Done (Listo).
5.	 Introduzca la dosis de aplicación de cada producto.
6.	 Seleccione el transportista.
7.	 Introduzca notas (opcional).
8.	 Haga clic en Save.

Añadir una mezcla al tanque
Planificar los totales de producto por depósito o por zona y 
documentar las cantidades exactas de producto.

1.	 Haga clic en Setup > Products > +Add > Tank Mix 
(Configuración > Productos > +Añadir > Mezcla de tanque).

2.	 Introduzca el nombre.
3.	 Seleccione los cultivos objetivo, introduzca la tasa de 

aplicación global y el tamaño del depósito.
4.	 Introduzca notas (opcional).
5.	 Haga clic en Select Products (Seleccionar productos), 

seleccione los productos que va a incluir, luego haga clic en 
Save Products (Guardar productos).

6.	 Seleccione el transportista.
7.	 Introduzca la dosis de aplicación o la cantidad por depósito 

de cada producto.
8.	 Haga clic en Save Tank Mix (Guardar mezcla de tanque).
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Añadir una mezcla seca
Obtenga cálculos exactos de cada producto de la mezcla,  
así como documentación precisa de sus aplicaciones.

1.	 Haga clic en Setup > Products > + Add > Dry Blend 
(Configuración > Productos > + Añadir > Mezcla seca).

2.	 Introduzca el nombre.
3.	 Seleccione los cultivos objetivo, introduzca el Área donde 

se va a aplicar.
4.	 Introduzca notas (opcional).
5.	 Haga clic en Select Products, haga clic en los productos 

que va a incluir, luego haga clic en Save Products.
6.	 Seleccione Input by Application Rate (Entrada por tasa de 

aplicación) o Input by Amount (Entrada por cantidad).
7.	 Introduzca la tasa de aplicación o la cantidad de producto 

de cada producto.
8.	 Haga clic en Save Dry Blend (Guardar mezcla seca).

MÓVIL
1.	 Haga clic en Setup > Products > Dry Blend > + Add 

(Configuración > Productos > Mezcla seca > + Añadir).
2.	 Introduzca el nombre.
3.	 Seleccione Target Crops (Cultivos objetivo).
4.	 Haga clic en Select Products (Seleccionar productos), 

haga clic en los productos que va a incluir, luego haga clic 
en Done.

5.	 Introduzca la tasa de aplicación o la cantidad de 
producto de cada producto.

6.	 Introduzca notas (opcional).
7.	 Haga clic en Save.
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MÓVIL
1.	 Haga clic en Setup > Team > Staff > + (Configuración > 

Equipo > Personal > + ).
2.	 Introduzca la dirección de correo electrónico del miembro del 

personal, seleccione la casilla de verificación si también será 
operario e introduzca el nombre del operario y la licencia de 
operario (opcional); a continuación, haga clic en Next.

3.	 Seleccione los niveles de acceso apropiados y luego haga clic 
en Next.

4.	 Asigne socios con los que el miembro del personal pueda 
trabajar, luego haga clic en Done.

Añadir un miembro del personal
Añada personal para ayudar a dirigir su organización.

1.	 Haga clic en Setup > Team > +Add > Staff Member 
(Configuración > Equipo > +Añadir > Miembro del personal).

2.	 Introduzca la dirección de correo electrónico del miembro 
del persona, seleccione la casilla de verificación si también 
será operario e introduzca el nombre del operario y la licencia 
de operario (opcional); a continuación, haga clic en Next.

3.	 Seleccione los niveles de acceso apropiados y luego haga clic 
en Next.

4.	 Asigne socios con los que el miembro del personal pueda 
trabajar, luego haga clic en Done.

Cómo configurar Operations Center John Deere
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Añadir un operario
Añada operarios a su organización si tiene miembros del 
equipo que trabajan para usted, pero no necesariamente 
necesitan acceso a su organización en el Centro de 
Operaciones.

1.	 Haga clic en Setup > Team > +Add > Operator 
(Configuración > Equipo > +Añadir > Operario).

2.	 Seleccione un miembro del personal en el menú desplegable 
o haga clic en Add New Operator (Añadir nuevo operario).

3.	 Introduzca el nombre del operario y la licencia del operario 
(opcional).

4.	 Haga clic en Save.

MÓVIL
1.	 Haga clic en Setup > Team > Operators > + 

(Configuración > Equipo > Operarios > +).
2.	 Introduzca el nombre del operario.
3.	 Introduzca la licencia del operario (opcional).
4.	 Haga clic en Save.
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Añadir una organización asociada
Permita que asesores de confianza presten apoyo a su 
organización de forma más eficiente.

1.	 Haga clic en Setup > Team > +Add > Partner Organization 
(Configuración > Equipo > +Añadir > Organización asociada).

2.	 Seleccione Grant Access (Conceder acceso) o Receive Access 
(Recibir acceso), introduzca la dirección de correo electrónico 
de la organización asociada y haga clic en Next.

3.	 Seleccione los niveles de acceso deseados y haga clic en Next.
4.	 Haga clic en Done.

MÓVIL
1.	 Haga clic en Setup > Team > Partners > + (Configuración > 

Equipo > Socios > + ).
2.	 Seleccione Grant Access o Receive Access, introduzca la 

dirección de correo electrónico de la organización asociada y 
haga clic en Next.

3.	 Seleccione los niveles de acceso deseados y haga clic en Next.

4.	 Haga clic en Done.
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Agregar un distribuidor
Habilite un servicio proactivo, soporte personalizado, 
conocimientos y capacitación.

1.	 Haga clic en Setup > Team > +Add > Dealer 
(Configuración > Equipo > +Añadir > Distribuidor).

2.	 Haga clic en Select Dealer (Seleccionar distribuidor), 
luego busque su distribuidor.

3.	 Busque la ubicación correcta de la tienda y,  
a continuación haga clic en Select Dealer.

4.	 Si desea compartir datos con este distribuidor,  
seleccione Yes (Sí) 
•  �Haga clic en Next, luego seleccione los niveles de 

acceso adecuados, luego haga clic en Next, luego haga 
clic en Done.

5.	 Si no desea compartir datos con este distribuidor, 
seleccione No y, a continuación, haga clic en Done.

MÓVIL
1.	 Haga clic en Setup > Team > Dealers > +  

(Configuración > Equipo > Distribuidores > +).
2.	 Seleccione Grant Access o Receive Access, introduzca 

la dirección de correo electrónico de la organización 
asociada y haga clic en Next.

3.	 Seleccione los niveles de acceso deseados y haga  
clic en Next.

4.	 Haga clic en Done.
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Editar el nivel de acceso del equipo
Controle quién tiene acceso y cuánto acceso tiene a su 
organización.

1.	 Haga clic en Setup > Team (Configuración > Equipo).
2.	 Haga clic en el miembro del personal, socio o distribuidor 

para el que desea cambiar el acceso.
3.	 Haga clic en Access (Acceso) y, a continuación, en Edit (Editar).
4.	 Modifique los niveles de acceso como desee.
5.	 Haga clic en Save.

Niveles de acceso sugeridos por función

Función Equipo Organización Ubicación Trabajo

Gerente, 
propietario o 
administrador 
de la granja

Nivel 3

+ RDA

+ WDT y 
configuración

Nivel 2 Nivel 3 Nivel 2

Agrónomo

Nivel 1

+ RDA

(WDT y 
configuración 

opcional)

Nivel 1 Nivel 3 Nivel 2

Técnico
Nivel 2

+ RDA
Nivel 1 Nivel 1 Nivel 0
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Activar AutoPath™
Permita que el Centro de Operaciones procese y cree líneas 
AutoPath™.

1.	 Haga clic en el nombre de la organización y, a continuación,  
en el símbolo de engranaje.

2.	 Seleccione la pestaña Feature Enablement (Activación de 
funciones), haga clic en el conmutador para activar AutoPath™.

Crear un nuevo archivo de configuración
Defina los detalles del trabajo para obtener una documentación 
más precisa y menos tiempo de preparación en el campo.

1.	 Haga clic en Setup > Setup File Creator (Configuración > 
Creador de archivos de configuración).

2.	 Seleccione Display Type (Tipo de visualización), introduzca 
un nombre de archivo, seleccione entre Create New ( Crear 
nuevo) o Create from Existing (Crear a partir de existente) y,  
a continuación, haga clic en Start (Iniciar).

3.	 Seleccione las características del terreno que desea incluir y a 
continuación haga clic en Next.

4.	 Seleccione las máquinas y los implementos en sus respectivas 
pestañas, luego haga clic en Next.

5.	 Seleccione los productos o las mezclas en sus respectiva 
pestañas y luego haga clic en Next.

6.	 Seleccione los operarios (opcional) y haga clic en Next.
7.	 Haga clic en Create File.
8.	 Si su máquina dispone de Transferencia Inalámbrica de Datos 

(WDT, por sus siglas en inglés), haga clic en Create and Send 
(Crear y enviar).

9.	 Si transfiere archivos manualmente a través de USB, haga clic 
en Create Without Sending (Crear sin enviar).

Crea un archivo de configuración en Operations Center 
John Deere
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Envío de archivos de configuración a equipos 
mediante transferencia inalámbrica de datos
Requisito: máquina conectada a JDLink™ 
Envíe detalles de trabajo definidos a las pantallas de las 
máquinas de forma remota desde su computadora para ayudar 
en la recogida de datos en limpio.

1.	 Haga clic en ...More > Files (...Más > Archivos).
2.	 Seleccione los archivos de configuración que desea enviar.
3.	 Haga clic en Transfer to Equipment (Transferencia al equipo).
4.	 Seleccione las máquinas a las que desea enviar archivos y, a 

continuación, haga clic en Transfer (Transferir).

Exportar un archivo de configuración a USB
Cargue detalles de trabajo definidos en las pantallas de la 
máquina para ayudar en la recopilación de datos limpia.

1.	 Haga clic en ...More > Files.
2.	 Seleccione los archivos de configuración que desea descargar 

y haga clic en Download (Descargar).
3.	 Seleccione su unidad USB como ubicación de descarga y haga 

clic en Download.
4.	 Recupere su archivo y muévalo a una unidad USB.

SUGERENCIA: Hable con su distribuidor John Deere local para equipar su 
máquina con un módem que permita la transferencia inalámbrica de datos.
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Añadir una conexión
Minimice la necesidad de importar/exportar datos manualmente 
o utilizar múltiples plataformas de software para gestionar sus 
operaciones.

1.	 Haga clic en Setup > Connections (Configuración > 
Conexiones).

2.	 Busque la compañía o el programa que desea conectar y haga 
clic en Connect (Conectar).

3.	 Cada conexión es diferente, pero tendrá que seleccionar 
Connect, a continuación, hacer clic en Login (Iniciar sesión) 
en la plataforma del software conectado y hacer clic en Agree 
(Aceptar) para conectar sus cuentas.

Utilizar la sincronización de datos
Sincronice los detalles de trabajo almacenados en todas  
las pantallas de su flota, asegurándose de que los datos 
aparecen en el Centro de Operaciones para facilitar su uso.

1.	 Haga clic en Setup > Data Sync (Configuración >  
Sincronización de datos).

2.	 Lea la descripción general para comprender cómo funciona la 
sincronización de datos y, a continuación, haga clic en Next.

3.	 Revise los datos de configuración de la organización y, a 
continuación, haga clic en Next.

4.	 Seleccione Import Settings (Configuración de importación),  
a continuación, haga clic en Next.

5.	 Seleccione las pantallas en las que desea activar la sincronización 
de datos y, a continuación, haga clic en Enable Displays (Activar 
pantallas).

NOTA: Es muy importante revisar los datos antes de sincronizarlos para asegurarse 
de que estén limpios y sean precisos.

Configuración de la sincronización de datos: cómo 
inscribirse y sincronizar
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Crear una "Geofence" (geocerca)  
y un toque de queda
Reciba notificaciones cuando el equipo abandone su ubicación 
definida o trabaje fuera de los horarios designados.

1.	 Haga clic en Setup > Geofences and Curfews  
(Configuración > Geocercas y toques de queda).

2.	 Haga clic en + junto a Create New (Crear nuevo).
3.	 Introduzca el nombre.
4.	 Haga clic en el botón Pointer (Puntero) o Rectangle 

(Rectángulo), a continuación dibuje la forma de la geocerca  
en el mapa.

5.	 Seleccione las alertas que quiera activar.
6.	 Haga clic en Add Operating Time Frame (Añadir marco 

temporal operativo) e introduzca el día y la hora.
7.	 Seleccione las máquinas a las que desea aplicar la geocerca.
8.	 Haga clic en Save.
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Planifique el trabajo para recopilar datos de alta calidad, 
ahorrar tiempo y reducir errores del operario en el campo. 
Dedique más tiempo a trabajar sobre el terreno y menos a 
configurar la pantalla para documentar el trabajo.

PLANIFICAR

Todas las instrucciones de tareas se deben usar 
a través de un navegador web, a menos que se 
indique algo distinto para dispositivos móviles.
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Crear un plan de trabajo
Requisito: pantallas Gen 4 y posteriores 
Defina y rellene automáticamente los detalles del trabajo para 
obtener una documentación más precisa y reducir el tiempo de 
configuración sobre el terreno.

1.	 Haga clic en Plan > Work Planner (Plan > Planificador  
de trabajo).

2.	 Seleccione el año y el tipo de trabajo y, a continuación, 
haga clic en +Plan (+Planificar).

3.	 Seleccione los campos que desea planificar y haga clic  
en Next.

4.	 Añada todos los detalles de trabajo posibles.
5.	 Haga clic en Save. 

Utilizar Work Planner (En Ingles)

MÓVIL
1.	 Haga clic en Plan (Planificar).
2.	 Seleccione el año y el tipo de trabajo, luego haga clic en +.
3.	 Seleccione los campos para los que desea planificar el trabajo 

y luego haga clic en Next. 
4.	 Añada todos los detalles de trabajo posibles.
5.	 Haga clic en Save work (Guardar trabajo).

https://www.youtube.com/watch?v=rVOaQvEb8VI&list=PL1KGsSJ4CWk6Ie1nD7AytQC1HA-uFF0pl&index=9
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Editar un plan de trabajo
Actualice los detalles del trabajo a medida que cambien los 
planes para garantizar que la documentación sea precisa.

1.	 Haga clic en Plan > Work Planner (Plan > Planificador  
de trabajo).

2.	 Seleccione el año y el tipo de trabajo.
3.	 Haga clic en el plan de trabajo que desea editar.
4.	 Modifique los detalles del trabajo según sea necesario y, 

a continuación, haga clic en Save.
5.	 Si el plan de trabajo ya se ha enviado a la máquina, vuelva 

a enviar el plan de trabajo a la máquina.

MÓVIL
1.	 Haga clic en Plan.
2.	 Seleccione el año y el tipo de trabajo.
3.	 Expanda el Plan de trabajo que desea editar y,  

a continuación, haga clic en Edit Work (Editar trabajo).
4.	 Modifique los detalles de trabajo según sea necesario y, 

a continuación, haga clic en Save Work.
5.	 Si el plan de trabajo ya se ha enviado a la máquina, vuelva 

a enviar el plan de trabajo a la máquina.
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Envío de archivos de configuración a equipos 
mediante transferencia inalámbrica de datos
Requisito: máquina conectada JDLink™ 
Envíe detalles de trabajo definidos a las pantallas de la máquina 
de forma remota para eliminar la necesidad de memorias USB.

1.	 Haga clic en Plan > Work Planner (Plan > Planificador  
de trabajo).

2.	 Seleccione el año y el tipo de trabajo.
3.	 Seleccione los planes de trabajo que desea enviar.
4.	 Haga clic en Send to Equipment (Enviar a equipo).
5.	 Seleccione las máquinas a las que desea enviar planes  

de trabajo y, a continuación, haga clic en Send (Enviar).

MÓVIL
1.	 Haga clic en Plan.
2.	 Seleccione el año y el tipo de trabajo.
3.	 Seleccione los planes de trabajo que desea enviar y,  

a continuación, haga clic en Send.
4.	 Seleccione las máquinas a las que desea enviar los planes  

de trabajo y, a continuación, haga clic en Next.
5.	 Haga clic en Send.
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Exportar un plan de trabajo a USB
Cargue los planes de trabajo con los detalles del trabajo en 
las pantallas de las máquinas para aumentar la precisión 
de la documentación para equipos no conectados.

1.	 Haga clic en Plan > Work Planner (Plan > Planificador 
de trabajo).

2.	 Seleccione el año y el tipo de trabajo.
3.	 Seleccione los planes de trabajo que desea exportar.
4.	 Haga clic en Send to Equipment > Send.
5.	 Haga clic en More > Files (Más > Archivos), a 

continuación en Go to Files (Ir a archivos). 
6.	 Seleccione archivos .zip del plan de trabajo, haga clic 

en Download, seleccione la ubicación de descarga y,  
a continuación, haga clic en Download.

7.	 Recupere el archivo de la ubicación seleccionada  
y muévalo a una unidad USB.
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Crear una receta de aplicación/siembra o laboreo
Requisito: equipo compatible con tasa variable, productos agregados 
antes del lanzamiento del programa TELUS Agronomy Prescription Creator 
Optimice la colocación de los insumos, reduciendo los gastos 
innecesarios en áreas del campo que tradicionalmente han 
tenido un menor rendimiento, al tiempo que maximiza el 
beneficio económico en las zonas de alto rendimiento.

1.	 Haga clic en Plan > TELUS Agronomy Prescription Creator.
2.	 Seleccione el tipo de receta.
3.	 Seleccione Organization (Organización ), Client (Cliente), Farm 

(Granja), Field (Campo) y Field Boundary (Límite de campo).
4.	 Seleccione su fuente de receta y la información necesaria y,  

a continuación, haga clic en Next.
5.	 Edite manualmente zonas, combine zonas y añada 

información específica de la operación.
6.	 Haga clic en Save, a continuación Save and Close.

Crear recetas (En Ingles)

https://www.youtube.com/watch?v=J_GC-26lmzE&list=PL1KGsSJ4CWk6Ie1nD7AytQC1HA-uFF0pl&index=10
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Configure correctamente su pantalla para garantizar que 
pueda aprovechar al máximo el conjunto de tecnologías que está 
disponible para usted. Asegúrese de que conoce la tecnología 
que puede utilizar en todos sus equipos.

EN LA CABINA
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Configuración  
de pantalla
Configure su pantalla e introduzca la información correcta para 
recopilar datos limpios y precisos.

SUGERENCIA: Active la sincronización de datos y utilice el 
planificador de trabajo para minimizar la cantidad de trabajo de 
configuración necesario en la cabina.

Seleccionar cliente, granja o campo

1.	 Haga clic en Menu > Applications > Work Setup (Menú > 
Aplicaciones > Configuración de trabajo).

2.	 Haga clic en Location (Ubicación), seleccione el cliente, la 
granja o el campo correctos y, a continuación, haga clic en OK.

Si su cliente, granja o campo no está en la lista, siga los pasos del 3 al 10.

3.	 Haga clic en View All (Ver todo).
4.	 Para un cliente nuevo, haga clic en Client > Edit Clients > New 

Client (Cliente > Editar clientes > Nuevo cliente).
5.	 Introduzca el nombre del cliente, luego haga clic en OK.
6.	 Para una nueva granja haga clic en Farm > Edit Farms > New 

Farm (Granja > Editar granjas > Nueva granja).
7.	 Introduzca el nombre de la granja y haga clic en OK.
8.	 Haga clic en Save.
9.	 Para un campo nuevo, haga clic en Field > New Field (Campo > 

Campo nuevo).
10.	 Introduzca el nombre del campo y haga clic en OK.
11.	 Haga clic en Save y luego en OK.
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Configuración de equipo

1.	 Haga clic en Menu > Applications > Work Setup (Menú > 
Aplicaciones > Configuración del trabajo).

2.	 Haga clic en Equipment (Equipo) y, a continuación, en 
Machine Profile (Perfil de la máquina).

3.	 Complete el perfil de la máquina editando las casillas blancas.
4.	 Haga clic en Save.

Configurar implemento

1.	 Haga clic en Menu > Applications > Work Setup.
2.	 Haga clic en Equipment y, a continuación, en Implement 

Profile (Perfil del implemento).
3.	 Complete el perfil del implemento editando las casillas 

blancas.
4.	 Haga clic en Save.

NOTA: Si su implemento no tiene una conexión ISOBUS (arnés de cableado), 
configurará un implemento virtual, para lo cual seleccione "Add Implement" 
(Agregar implemento) y siga los pasos en pantalla.
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Configuración de los detalles de trabajo

Operario
1.	 Haga clic en Menu > Applications > Work Setup (Menú > 

Aplicaciones > Configuración de trabajo)
2.	 Haga clic en la imagen de una persona en Details (Detalles).
3.	 Seleccione el nombre del operario y haga clic en OK.

Si el nombre del operario no aparece en la lista, añada un nuevo 
operario siguiendo los pasos del 4 al 7.

4.	 Haga clic en Add Operator (Añadir operario).
5.	 Haga clic en la casilla blanca junto a Name (Nombre), 

introduzca el nombre del operario, luego haga clic en OK.
6.	 Haga clic en la casilla blanca junto a License (Licencia), 

introduzca el número de licencia, luego haga clic en OK 
(opcional).

7.	 Haga clic en Save.

Temporada
1.	 Haga clic en Season (Temporada) en Details.
2.	 Haga clic en las flechas izquierda o derecha para seleccionar el 

año y, a continuación, en OK.
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Crear un límite por conducción

1.	 Conduzca hasta el punto de partida del límite.
2.	 Haga clic en Menu > Applications > Fields & Boundaries 

(Menú > Aplicaciones > Campos y límites).
3.	 Haga clic en Create Boundary (Crear límite).
4.	 Haga clic en Create Standard Driven Boundaries (Crear límites 

basados en normas).
5.	 Haga clic en OK.
6.	 Haga clic en la casilla blanca debajo de Name e ingrese el 

nombre del límite, luego haga clic en OK.
7.	 Elija Offset Point (Punto de desplazamiento).
8.	 Haga clic en la flecha para el lado de la ubicación de 

desplazamiento.
9.	 Introduzca el desplazamiento límite y haga clic en OK.
10.	 Haga clic en Start Recording (Iniciar grabación).
11.	 Marque el límite y haga clic en Save.
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Seleccionar o crear líneas de  
Guidance Track/AutoPath™.

1.	 Haga clic en Menu > Applications > AutoTrac™ Guidance 
(Menú > Aplicaciones > Guía AutoTrac™).

2.	 Haga clic en Set Track (Configurar pista).
3.	 Seleccione una pista de la lista disponible y haga clic en OK.

Para crear una nueva pista, complete los pasos del 4 al 8. 
Para crear un nuevo conjunto de pistas, siga los pasos del 9 al 13.

4.	 Haga clic en New Track (Nueva pista).
5.	 Seleccione el método de orientación.
6.	 Para cambiar el nombre de la pista, haga clic en el lápiz 

debajo de Track Name (Nombre de pista) y haga clic en OK.
7.	 Verifique el campo y el cálculo de la línea de guía y luego 

haga clic en OK.
8.	 Siga las instrucciones de la casilla roja para grabar una  

nueva pista.
9.	 Haga clic en New Track Set (Nuevo conjunto de pistas).
10.	 Para cambiar el nombre del conjunto de pistas, haga clic en  

el lápiz debajo de Track Set Name (Nombre del conjunto de 
pistas) y haga clic en OK.

11.	 Haga clic en Add Track (Añadir pista).
12.	 Seleccione la pista de la lista y haga clic en Save.
13.	 Repita el proceso hasta que haya añadido todas las pistas  

que desee.
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Resumen del trabajo - Laboreo

1.	 Haga clic en Menu > Applications > Work Setup (Menú > 
Aplicaciones > Configuración de trabajo).

2.	 Haga clic en la casilla del componente de conexión a 
tierra.

3.	 Para configurar su tasa objetivo o utilizar una receta, 
haga clic en la casilla blanca junto a Target Rate/Rx (Tasa 
objetivo/Rx).

4.	 Si utiliza una tasa de controlador, haga clic en Set 
(Configurar) y llene la información correspondiente.

5.	 Si utiliza una receta, haga clic en la casilla blanca junto a 
Rx (Receta).

6.	 Seleccione la receta correcta.
7.	 Haga clic en OK.
8.	 Verifique la información y haga clic en Save.
9.	 Verifique la información y haga clic en X.



43

LI
ST

AS
 D

E 
 

VE
RI

FI
CA

CI
Ó

N
CO

N
FI

GU
RA

R
PL

AN
IF

IC
AR

EN
 L

A 
CA

BI
N

A
M

O
N

IT
O

RE
AR

AN
AL

IZ
AR

Resumen del trabajo - Plantación

1.	 Haga clic en Menu > Applications > Work Setup (Menú > 
Aplicaciones > Configuración de trabajo).

2.	 Para editar su tipo de cultivo, haga clic en la casilla blanca 
junto a Crop (Cultivo).

3.	 Busque su cultivo en la lista, selecciónelo y haga clic en OK.
4.	 Para añadir la variedad, haga clic en la casilla blanca junto a 

Variety (Variedad).
5.	 Añada hasta seis variedades haciendo clic en la casilla blanca 

Single (Única), Dual (Doble) o Custom (Personalizado) y 
escriba la variedad, después haga clic en OK.

6.	 Para personalizar, después de introducir el nombre de la 
variedad, marque las casillas para asignar la variedad a las 
filas correspondientes.

7.	 Haga clic en Target Rate/Rx.
8.	 Si utiliza una tasa de controlador, haga clic en Set (Configurar) 

y llene la información correspondiente.
9.	 Si utiliza una Rx, haga clic en la casilla blanca.
10.	 Seleccione la receta correcta.
11.	 Haga clic en OK.
12.	 Verifique la información y haga clic en Save.
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Resumen de trabajo - aplicación

1.	 Haga clic en Menu > Applications > Work Setup  
(Menú > Aplicaciones > Configuración de trabajo).

2.	 Para editar su tipo de cultivo, haga clic en la casilla blanca junto a Crop.
3.	 Busque su cultivo en la lista All Crops (Todos los cultivos), selecciónelo 

y haga clic en OK.
4.	 Seleccione Single Product (Producto único) o Tank Mix (Mezcla  

de tanque).

Si aplica un solo producto, complete los pasos del 5 al 11.  
Si utiliza una mezcla de tanque, complete los pasos del 12 al 18.

5.	 Si utiliza un solo producto, haga clic en el círculo junto a Single 
Product.

6.	 Haga clic en la casilla blanca junto a Product Name (Nombre de 
producto).

7.	 Si aparece en la lista precargada, seleccione el producto que desea 
aplicar de la lista y haga clic en OK.

8.	 Si el producto no aparece en la lista, haga clic en All Products  
(Todos los productos).

9.	 Seleccione el tipo de producto.
10.	 Seleccione el producto que desea aplicar en Product Name (Nombre 

de producto).
11.	 Haga clic en OK.
12.	 Si utiliza una mezcla de tanque, haga clic en el círculo junto a Tank Mix.
13.	 Si la mezcla de tanque no está en la lista precargada, haga clic en New 

Tank Mix (Nueva mezcla de tanque).
14.	 Introduzca el nombre de la mezcla y haga clic en Next.
15.	 Introduzca la tasa de mezcla del tanque y asegúrese de haber 

seleccionado las unidades correctas, luego haga clic OK.
16.	 Seleccione su operario y haga clic en OK.
17.	 Haga clic en Add Product (Añadir producto) para añadir todos los 

demás productos en su mezcla de tanque (consulte los pasos del 9 a 11) 
después de hacer clic en + Add Product (+Añadir producto).

18.	 Haga clic en OK.
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Resumen de trabajo - Cosecha

1.	 Haga clic en Menu > Applications > Work Setup  
(Menú > Aplicaciones > Configuración de trabajo).

2.	 Para editar su tipo de cultivo, haga clic en la casilla blanca 
junto a Crop.

3.	 Busque su cultivo en la lista, selecciónelo y haga clic en OK.
4.	 Para añadir la variedad, haga clic en la casilla blanca junto a 

Variety.

Si cosecha una sola variedad, complete los pasos del 5 al 8 y el 13. 
Si utiliza un mapa de localización de variedades, complete los 
pasos del 9 al 13.

5.	 Para una sola variedad, haga clic en la casilla blanca junto a 
Single Variety (Variedad única).

6.	 Si aparece en la lista precargada, seleccione la variedad que  
va a cosechar y haga clic en OK.

7.	 Si el producto no está en la lista precargada, haga clic  Add 
Variety (Añadir variedad) e introduzca el nombre de la 
variedad; a continuación, haga clic en OK.

8.	 Haga clic en OK tres veces para volver al Work Setup Menu 
(Menú de configuración de trabajo).

9.	 Para Mapa de localización de variedades, haga clic en la 
casilla blanca junto a Variety Locator Map (Mapa localizador 
de variedades).

10.	 Haga clic en la casilla blanca debajo de Variety Map (Mapa  
de variedades).

11.	 Seleccione el mapa de variedades correcto de la lista.
12.	 Haga clic en OK tres veces para volver al menú de 

configuración de trabajo.
13.	 Seleccione la unidad de recolección y haga clic en OK.



46

LI
ST

AS
 D

E 
 

VE
RI

FI
CA

CI
Ó

N
CO

N
FI

GU
RA

R
PL

AN
IF

IC
AR

EN
 L

A 
CA

BI
N

A
M

O
N

IT
O

RE
AR

AN
AL

IZ
AR

Editar barras de atajos

1.	 Haga clic en Menu > Applications > Layout Manager 
(Menú > Aplicaciones > Administrador de diseño).

2.	 Haga clic en Shortcut Bars (Barras de atajos).
3.	 Haga clic en Create New Shortcut Bar (Crear nueva barra 

de acceso directo) o edite la barra de acceso directo 
predeterminada haciendo clic en el lápiz.

4.	 Siga las instrucciones que aparecen en pantalla para 
añadir un nuevo acceso directo, mover los existentes 
a una nueva área o eliminar accesos directos.

5.	 Haga clic en Save.
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Configuración 
de máquinas e 
implementos
Asegúrese de haber ingresado las medidas correctas y haber 
calibrado la máquina y los implementos para recopilar datos 
precisos.

Realizar mediciones y calibraciones de máquinas

1.	 Complete las mediciones correspondientes de la siguiente 
lista e introdúzcala en el perfil de la máquinao en el perfil  
del implemento

· Anchura de trabajo (número de filas y anchura de fila) 
· Desplazamientos laterales por GPS 
· Desplazamientos de pivote 
· Altura GPS y Adelante/Después 
· Centro de rotación

2.	 Realice una calibración TCM haciendo clic en Menu > 
Applications > StarFire™ > Advanced TCM Calibration >  
Begin Calibration (Menú > Aplicaciones > StarFire™ > 
Calibración TCM avanzada > Iniciar calibración).

3.	 Siga las instrucciones en pantalla.

Calibración avanzada de TCM StarFire™ (En Ingles)
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Añadir un receptor de implementos

1.	 Haga clic en Menu > Applications > Work Setup (Menú > 
Aplicaciones > Configuración de trabajo).

2.	 Haga clic en Equipment (Equipo).
3.	 Haga clic en Implement Profile.
4.	 Desplácese hasta Implement Receiver (Receptor de 

implemento).
5.	 Haga clic en Add Receiver Mount (Agregar soporte para 

receptor).
6.	 Introduzca su Desplazamiento lateral y Desplazamiento 

en línea.
7.	 Asegúrese de que esté seleccionado un receptor GPS.
8.	 Haga clic en OK.
9.	 Active la Guía de implementos a ON.
10.	 Vuelva al menú.
11.	 Haga clic en Applications > StarFire™ (Aplicaciones > 

StarFire™).
12.	 Haga clic en Connected Receiver (Receptor conectado)
13.	 Haga clic en Setup (Configuración).
14.	 Ingrese las medidas de adelante/atrás y altura.
15.	 Haga clic en X. 
16.	 Realice una calibración TCM (consulte la página 47).
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Configurar controladores de dosis

1.	 Después de que se inicie la pantalla, espere a que aparezca el 
mensaje “Equipment Detected” (Equipo detectado) y haga clic 
en Next para iniciar la configuración.

2.	 Haga clic en Add Implement (Añadir implemento) y seleccione 
el perfil del implemento, a continuación haga clic en OK.

3.	 Seleccione el implemento de la lista de equipo conectado y 
haga clic en OK.

4.	 Modifique los ajustes dentro de Implement Profile según sea 
necesario y haga clic en Save.

5.	 Supervise el rendimiento y ajuste la configuración haciendo clic 
en Menu > Applications > ISOBUS VT (Menú > Aplicaciones > 
ISOBUS VT).

SUGERENCIA: Cree una página de ejecución ISOBUS VT para acceder fácilmente al 
rendimiento y los ajustes.
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Automatización de 
giros AutoTrac™ (ATTA)
Aumente la eficiencia y precisión del operario: planifique y 
ejecute giros precisos y uniformes, pasada tras pasada.

Completar la configuración requerida  
de la pantalla y el equipo

1.	 Mida e introduzca todas las dimensiones de la máquina y del 
implemento (consulte la página 47).

2.	 Realice una calibración TCM (consulte la página 47).
3.	 Introduzca los campos cliente, granja y campo (consulte  

la página 37).

Configurar el límite de cabecera

1.	 Haga clic en Menu > Applications > Fields and Boundaries 
(Menú > Aplicaciones > Campos y límites).

2.	 Haga clic dentro de la casilla blanca delimitadora grande
3.	 Haga clic en el lápiz para editar el límite exterior.
4.	 Seleccione una cabecera 

•  Para desplazamiento constante, introduzca desplazamiento 
•  �Para desplazamientos superior e inferior, introduzca ángulo de 

rumbo, desplazamiento superior y desplazamiento inferior
5.	 Haga clic en Save.

Configuración de la pantalla de automatización 
de giro AutoTrac™ (En Ingles)

https://view.highspot.com/viewer/655e8512cf50171b8a61b60d
https://view.highspot.com/viewer/655e8512cf50171b8a61b60d
https://view.highspot.com/viewer/655e8512cf50171b8a61b60d
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Configurar secuencias de cabecera

1.	 Haga clic en Menu > Applications > AutoTrac™ Turn 
Automation (Menú > Aplicaciones > Automatización de giros 
AutoTrac™).

2.	 Dentro de Headlands (Cabeceras), haga clic en Enter (Ingresar).
3.	 Haga clic para añadir una New Sequence (Nueva secuencia).
4.	 Haga clic para Add Step (Añadir paso).
5.	 Desplácese para seleccionar una función.
6.	 Seleccione la acción.
7.	 Introduzca la información correspondiente y haga clic en OK.
8.	 Haga clic en Next.
9.	 Asigne un nombre a la secuencia y haga clic en OK.
10.	 Haga clic en Save.
11.	 Dentro de Headlands, haga clic en Exit (Salir).
12.	 Repita los pasos del 3 al 10 para completar la configuración  

de la función del implemento.
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Ajustar la configuración de giro

1.	 Haga clic en Menu > Applications > AutoTrac™ Turn 
Automation (Menú > Aplicaciones > Automatización de 
giros AutoTrac™).

2.	 Haga clic en Aggressiveness setting (Ajuste de agresividad).
3.	 Ajuste la configuración de agresividad según sea necesario 

y haga clic en X.
4.	 Haga clic dentro de Start Turn (Iniciar turno).
5.	 Ajuste la configuración de inicio de giro según sea necesario 

y haga clic en X.
6.	 Asegúrese de que el control de velocidad está en ON.
7.	 Haga clic dentro de Max Turn Speed (Velocidad máxima  

de giro).
8.	 Haga clic en la casilla blanca editable. 
9.	 Introduzca la velocidad máxima de giro deseada.
10.	 Haga clic en OK y en X.
11.	 Haga clic dentro de Max In-Field Speed (Velocidad máxima 

en campo).
12.	 Haga clic en la casilla blanca editable. 
13.	 Ingrese la velocidad máxima deseada en el campo.
14.	 Haga clic en OK y en X.

Activar ATTA

1.	 Haga clic en Menu > Applications > AutoTrac™ Turn 
Automation (Menú > Aplicaciones > Automatización  
de giros AutoTrac™).

2.	 Haga clic en ON.
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Ajustar sentido de giro y saltar fila

1.	 Mientras utiliza ATTA, vea la flecha de giro circular en la página 
de ejecución.

2.	 Haga clic en la flecha de giro circular.
3.	 Ajuste la dirección de giro pulsando la flecha correcta.
4.	 Para añadir saltos de filas, haga clic en la flecha de giro en  

la dirección que desea girar.
5.	 Para eliminar saltos de filas, haga clic en la flecha de dirección 

opuesta.
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AutoPath™ (filas)
Obtenga una precisión inigualable a través de líneas 
de guía autogeneradas basadas en hileras de cultivos 
reales plantadas. AutoPath™ disminuye el tiempo de 
preparación, agiliza la operación y reduce los daños a 
los cultivos. Independientemente del ancho del equipo, 
sabrá exactamente en qué filas comenzar durante toda 
la temporada de cultivo, lo que eliminará conjeturas y 
maximizará el rendimiento y la eficiencia generales.

Completar la configuración requerida  
de la pantalla y el equipo

1.	 Verifique que los perfiles de la máquina y del implemento 
estén completos con medidas precisas (consulte la página 47).

2.	 Verifique que se ha añadido y configurado el receptor de 
implementos (consulte la página 48).

3.	 Realice un calibrado avanzado de TCM (consulte la página 48).

Configuración de visualización de ruta automática (filas) 
(En Ingles)

https://view.highspot.com/viewer/655e7fac30fb06289927424a
https://view.highspot.com/viewer/655e7fac30fb06289927424a
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Utilizar un plan de trabajo planificado

1.	 Después de ingresar al límite del campo, los planes de trabajo 
creados anteriormente se rellenarán automáticamente con las 
líneas AutoPath™ incluidas.

Habilite la grabación de AutoPath™ en la pantalla 
durante las operaciones de fuente.

1.	 Haga clic en el botón Information & Settings (Información 
y Configuración) de la cinta Work Setup (Configuración de 
trabajo).

2.	 Haga clic en Settings (Configuración) y luego haga clic en 
Enable AutoPath™ Recording Status (Habilitar estado de 
grabación de AutoPath™).

3.	 Haga clic en X.
4.	 Si la luz está verde en la sección AutoPath™ Recording, está 

listo para grabar.
5.	 Si está en rojo, haga clic en la luz para ver lo que queda por 

configurar.
6.	 Los primeros cuatro elementos de la línea necesitan una marca 

de verificación verde para estar listos para grabar. 
7.	 Haga clic en el botón de flecha de cada línea para ir a la página 

para ingresar la configuración.

NOTA: El ícono de atención junto a “Verify Implement Fore/Aft and Height” 
(Verificar implemento adelante/atrás y altura) puede permanecer encendido, 
incluso durante la grabación de líneas AutoPath™.

NOTA: Los planes de trabajo son el método más sencillo para recibir líneas de 
AutoPath™ para pases posteriores. Consulte las instrucciones para crear planes 
de trabajo en el Centro de Operaciones en la página 31. 
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Seleccionar AutoPath™ para la guía.

1.	 Haga clic en Menu > AutoTrac™ Guidance > Set Track 
(Menú > Guía AutoTrac™ > Configurar pista).

2.	 Haga clic en AutoPath™ y, a continuación, en OK.
3.	 Haga clic en Set Track (Configurar pista), a continuación, 

haga clic en el lápiz para editar AutoPath™.
4.	 Haga clic en Generation (Generación) y, a continuación, 

seleccione Rows, optimize for fewest paths (Filas, 
optimizar para el menor número de rutas) o Rows, follow 
source operation paths (Filas, seguir rutas de operaciones 
de origen).

5.	 Haga clic en OK y, a continuación, en OK.
6.	 Haga clic en AutoTrac™ ON y, a continuación, en X.

Activar AutoTrac™

1.	 Comience a conducir hasta que la línea de guía que 
desea seguir se vuelva blanca.

2.	 Haga clic en el botón de reanudación de AutoTrac™ 
para activar.
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Guía de implementos 
AutoTrac™
Mejore la precisión de los implementos reduciendo las desviaciones 
mediante la guía de implementos AutoTrac™. Confíe en que está 
maximizando sus entradas colocándolas justo donde deben estar, 
pasada tras pasada.

Completar la configuración requerida  
de la pantalla y el equipo

1.	 Verifique que los perfiles de la máquina y del implemento 
estén completos con medidas precisas (consulte la página 47).

2.	 Verifique que el receptor de implementos se ha añadido al perfil 
y se ha configurado correctamente (consulte la página 48).

3.	 Realice un calibrado avanzado de TCM (consulte la página 47).

Activar la guía de implementos AutoTrac™.

1.	 Haga clic en Menu > Applications > AutoTrac™ Guidance 
(Menú > Aplicaciones > Guía AutoTrac™).

2.	 Haga clic en Information and Settings (Información y 
configuración).

3.	 En AutoTrac™ Implement Guidance (Guía de implementos de 
AutoTrac™) haga clic en ON.

4.	 Haga clic en X, a continuación, en AutoTrac™, haga clic en ON.
5.	 Haga clic en X

Configuración de la pantalla de guía de implementos 
de AutoTrac (En Ingles)

https://view.highspot.com/viewer/655e858616ba7023d61b180b
https://view.highspot.com/viewer/655e858616ba7023d61b180b
https://view.highspot.com/viewer/655e858616ba7023d61b180b
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Activar AutoTrac™

1.	 Comience a conducir hasta que la línea de guía que desea 
seguir se vuelva blanca.

2.	 Haga clic en el botón de reanudación de AutoTrac™, que 
activa automáticamente la Guía de implementos AutoTrac™.

Optimizar la sensibilidad de la Guía  
de implementos AutoTrac™.

1.	 Haga clic en Information & Settings en la parte superior 
de la página.

2.	 Haga clic en el botón del volante debajo de AutoTrac™ 
Steering Optimization (Optimización de dirección 
AutoTrac™).

3.	 Haga clic en Implement Steering (Implementar dirección) 
y ajuste la configuración como desee.

NOTA: Las definiciones de configuración se pueden encontrar en los 
documentos de ayuda a los que se accede haciendo clic en el ícono de 
información en la parte superior de la página.
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NOTA: Cada máquina del grupo de trabajo debe tener activada la Sincronización 
de máquinas y tener instalada una antena de sincronización de máquinas de alta 
conectividad.

NOTA: Si cosecha con una cosechadora, la zona operativa predeterminada con 
esta opción desactivada se encuentra a la izquierda de la cosechadora.

Sincronización  
de máquinas
Descargue cultivos con confianza sobre la marcha a través de una 
sincronización confiable y automatizada de máquina a máquina durante 
una operación de cosecha mediante la sincronización de máquinas. Tenga 
la tranquilidad de saber que el sistema mantendrá las máquinas a una 
distancia segura unas de otras durante el proceso de descarga.

Activar la sincronización de máquinas - Líder

1.	 Vaya a Menu > Applications > Machine Sync (Menú > 
Aplicaciones > Sincronización de máquinas).

2.	 Active el interruptor de sincronización de la máquina a ON.
3.	 Edite el nombre de red y la contraseña.

Definir la zona operativa - Líder

1.	 Machine Sync > Information & Settings (Sincronización de 
máquinas > Información y configuración)

2.	 Seleccione U-Shaped Operational Zone Override Toggle 
(Interruptor de anulación de zona operativa en forma de U) 
· Cosechadora/Tractor – Apagado 
· Dos tractores – Encendido 
· SPFH – Encendido

3.	 Introduzca la anchura y longitud de la zona operativa

Configuración de la pantalla de sincronización  
de máquinas (En Ingles)

https://view.highspot.com/viewer/6564af523b88155430c9e760
https://view.highspot.com/viewer/6564af523b88155430c9e760
https://view.highspot.com/viewer/6564af523b88155430c9e760
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Configurar el punto de partida - Líder

Punto de origen único (cosechadora/tractor)
1.	 Seleccione Set Home Point (Fijar punto de inicio) cuando el 

tractor haya alcanzado la posición de descarga deseada.

Múltiples puntos de inicio – Forma de U (dos tractores / SPFH)

1.	 Seleccione Set (Configurar) en la palanca Set/Engage 
(Configurar/Activar).

2.	 Seleccione el número de puntos locales.
3.	 Para cambiar un punto de origen activo, seleccione Engage 

(Activar) en la palanca Set/Engage.
4.	 Seleccione el número de puntos locales.

Activar la sincronización de la máquina - Líder

1.	 Cuando el seguidor activa el botón de reanudación de 
AutoTrac™ dentro de la zona operativa, la luz de la 
sincronización de máquinas cambiará de verde a azul.

2.	 El líder ahora puede controlar y empujar al seguidor a  
las ubicaciones deseadas para un llenado uniforme.
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Empujar - Líder

1.	 Haga clic en Information and Settings. 
2.	 Ajuste el incremento en línea y el lateral a su configuración 

preferida.
3.	 Haga clic en X.
4.	 Cuando el seguidor ha activado AutoTrac™ en la zona 

operativa y ha sido "capturado", el líder puede empujar  
al seguidor con los botones direccionales.

Únase al grupo de trabajo - Seguidor

1.	 Haga clic en Menu > Applications > Sharing (Menú > 
Aplicaciones > Compartir).

2.	 Haga clic en la casilla Enable Sync to Operations Center 
(Activar sincronización con el Centro de operaciones) y 
Enable Sync from Operations Center (Activar 
sincronización desde el Centro de operaciones).

3.	 Haga clic en X > Work Setup (X > Configuración de trabajo).
4.	 Haga clic en Perfil de la máquina.
5.	 Haga clic en Add Implement (Añadir implemento).
6.	 Cree un implemento virtual (NO seleccione Sí para la 

configuración del "Carrito". Esto es para configurar un 
carrito de aire).

7.	 Seleccione Add Operation (Añadir operación).
8.	 Configure el tipo de operación en Harvesting (Cosecha).

NOTA: Para obtener información sobre el uso compartido de datos en el campo 
mientras se utiliza Machine Sync, asegúrese de que todas las máquinas del mismo 
grupo de trabajo tengan su operación configurada en "Harvesting". Esto se puede 
hacer configurando un implemento virtual en los tractores.
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Activar Machine Sync - Seguidor

1.	 Vaya a Menu > Applications > Machine Sync (Menú > 
Aplicaciones > Sincronización de máquinas).

2.	 Cambie el interruptor de palanca de la máquina a ON.

Unirse a la red de líderes

1.	 En el menú de sincronización de máquinas, seleccione la red 
en Selected Leader (Líder seleccionado).

2.	 Seleccione la red correcta de la lista.
3.	 Introduzca la contraseña configurada en la máquina del líder.

Definir la función del tractor - Seguidor

1.	 En el menú de sincronización de máquinas, seleccione 
Information & Settings.

2.	 Desplácese hacia abajo hasta Tractor Role Setting 
(Configuración de rol del tractor).

3.	 Según el tipo de operación, seleccione: 
· El tractor es líder 
· El tractor es seguidor

NOTA: Machine Sync debe estar activada en cada máquina que forme parte 
del grupo de trabajo.
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Comprobar que el tráfico controlado está 
activado para el seguidor (opcional)

1.	 Asegúrese de que las máquinas 1 y 2 están en el mismo 
grupo de trabajo.

2.	 Cree una nueva línea de orientación en la máquina 1 y 
compártala con la máquina 2 (las líneas de orientación solo 
deben transferirse si se crean después de unir los grupos de 
trabajo).

3.	 Seleccione una línea existente y comparta la línea de guía 
con la máquina 2 usando el ícono de la nube.

4.	 Haga que la máquina 2 use la línea de guía y luego 
desplácela (los desplazamientos solo los utiliza la máquina 
receptora una vez que no se esté usando activamente la 
línea para AutoTrac™ y se vuelva a seleccionar).

Activar la sincronización de máquinas - Seguidor

Seguidor

1.	 Entre en zona operativa (señalada en naranja en la pantalla)
2.	 Haga clic en el interruptor de reanudación de AutoTrac™ 

para que se active cuando el estado indique que está listo.
3.	 La luz de la sincronización de máquinas cambiará de verde a 

azul para indicar que la máquina está siendo controlada.

NOTA: Se recomienda que el seguidor configure una velocidad máxima el doble 
que la del líder y acelere al máximo para obtener el mejor rendimiento de la 
sincronización de máquinas.
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Intercambio de datos 
en el campo
Asegúrese de que los operarios están trabajando de forma 
eficiente compartiendo mapas de aplicación y líneas de guía 
entre las máquinas que se utilizan para laborear, plantar, 
aplicar y cosechar.

Completar la configuración requerida de la 
pantalla y el equipo

1.	 Elija el cliente, la granja o el campo en el que trabaja 
(consulte la página 37).

2.	 Introduzca el nombre del operario (consulte la página 39).
3.	 Introduzca las dimensiones de la máquina y del 

implemento (consulte la página 47).
4.	 Habilite el uso compartido haciendo clic en Menu > 

Applications > Sharing (Menú > Aplicaciones > Compartir).

Configuración de pantalla para compartir 
datos en el campo (En Ingles)

https://view.highspot.com/viewer/655e85cd588a8f2b90629eef
https://view.highspot.com/viewer/655e85cd588a8f2b90629eef
https://view.highspot.com/viewer/655e85cd588a8f2b90629eef
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Compartir líneas de orientación y turnos

1.	 Haga clic en Cloud icon > Guidance Line List  
(Icono de nube > Lista de líneas guía).

2.	 Utilice turnos de otras máquinas.
3.	 Anule la selección y vuelva a seleccionar la línea de 

orientación de la lista de pistas de orientación o de 
intercambiar pistas

Compartir trabajo

Unirse al grupo de trabajo
Los datos del grupo de trabajo se comparten automáticamente 
según el campo seleccionado y el tipo de operación.

·  Plantación - Selección del campo y tipo de cultivo 
·  Cosecha - Selección del campo y tipo de cultivo 
·  �Aplicación - Selección de campo y nombre del producto  

o de la mezcla de tanque

Seleccionar de la lista de trabajo compartido
1.	 Haga clic en Menu > Applications > Work Setup > Work List 

(Menú > Aplicaciones > Configuración de trabajo > Lista de 
trabajo).

2.	 Seleccione el trabajo de la Lista de trabajos compartidos 
ordenada geoespacialmente.
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Monitoree el equipo y el progreso del trabajo en el Centro de 
Operaciones para identificar de forma preventiva los problemas 
que podrían causar tiempos de inactividad, manteniendo sus 
equipos funcionando de forma más eficiente durante toda la 
temporada.

MONITOREAR

Todas las instrucciones de tareas se deben usar 
a través de un navegador web, a menos que se 
indique algo distinto para dispositivos móviles.
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Monitorear su equipo
Vea la utilización de la máquina, el rendimiento, los códigos 
de diagnóstico de problemas (DTC, por sus siglas en inglés) 
y la información de mantenimiento.

1.	 Haga clic en Map > Equipment (Mapa > Equipo).
2.	 Seleccione la máquina que desea monitorear.
3.	 Ajuste los filtros de fechas como desee.
4.	 Haga clic en Summary (Resumen) para ver la utilización, 

las horas de funcionamiento y las métricas de rendimiento.
5.	 Haga clic en Alerts (Alertas) para ver cualquier DTC de la 

máquina.
6.	 Haga clic en Maintenance (Mantenimiento) para ver los 

planes de mantenimiento.
7.	 Haga clic en Setup (Configuración) para asegurarse de que 

la máquina, el módem y la pantalla estén configurados.

MÓVIL
1.	 Haga clic en Map > Equipment.
2.	 Seleccione la máquina que desea monitorear.
3.	 Haga clic en Right Now (Ahora mismo) para ver los detalles 

actuales del vehículo.
4.	 Haga clic en Today (Hoy) para ver los detalles de uso y 

rendimiento.
5.	 Haga clic en Work (Trabajo) para ver el historial de trabajo 

de la máquina.
6.	 Haga clic en Alerts (Alertas) para ver los DTC de la máquina.
7.	 Haga clic en Setup (Configuración) para ver la información 

de configuración del equipo.
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Acceso remoto a pantalla (RDA, por sus siglas 
en inglés) en una máquina
Requisito: máquina conectada JDLink™. 
Confíe en la calidad del trabajo, posibilite una resolución de 
problemas más rápida y mejore el servicio del personal de 
asistencia y del concesionario John Deere con una reducción 
en los costos de mano de obra y desplazamiento.

1.	 Haga clic en Map > Equipment.
2.	 Seleccione la máquina a la que desea conectarse 

remotamente.
3.	 Haga clic en RDA. 

Crear una alerta personalizada de la máquina
Reciba notificaciones automáticas en su teléfono cuando las  
máquinas superen los umbrales de velocidad y tiempo de inactividad.

MÓVIL
1.	 Haga clic en Home > View All Equipment (Inicio > Ver todos los 

equipos).
2.	 Seleccione la máquina para la que desea crear la alerta.
3.	 Haga clic en Alerts (Alertas).
4.	 Haga clic en Add (Añadir) a la derecha de cualquiera de las opciones 

de alerta personalizada.
5.	 Ajuste la configuración haciendo clic en +/-, luego haga clic en Save.

MÓVIL
1.	 Haga clic en Map > Equipment. 
2.	 Seleccione la máquina a la que desea conectarse remotamente.
3.	 Haga clic en RDA.

Monitoree su explotación (En Ingles)

NOTA: Debe permitir las notificaciones automáticas. Esta opción puede activarse en la 
aplicación móvil seleccionando Profile > Alert Settings (Perfil > Configuración de alertas).

https://www.youtube.com/watch?v=kjluKTzm7I0&list=PL1KGsSJ4CWk6Ie1nD7AytQC1HA-uFF0pl&index=13
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Añadir etiquetas al equipo
Agrupe los equipos para facilitar su monitoreo en el mapa y 
agilizar la configuración de los informes de varias máquinas.

1.	 Haga clic en Map > Equipment (Mapa > Equipo).
2.	 Seleccione la máquina que desea etiquetar.
3.	 Haga clic en Manage Tags (Gestionar etiquetas).
4.	 Seleccione las etiquetas que desea asignar a la máquina.
5.	 Si necesita una nueva etiqueta, haga clic en +Add Tag 

(+Añadir etiqueta) e introduzca el nombre de la etiqueta, 
seleccione la visibilidad, seleccione todos los equipos que 
desea añadir a la etiqueta.

6.	 Haga clic en Save.

Ver el progreso del trabajo activo y el tiempo 
estimado restante
Requisito: pantalla Gen 4 o posterior, software 20-3 o posterior y 
dentro de un límite de campo 
Gestionar eficazmente el trabajo y la logística sabiendo 
cuándo se hará un trabajo.

MÓVIL
1.	 Haga clic en Home (Inicio).
2.	 Desplácese hasta Active Work (Trabajo activo).
3.	 Consulte el tiempo estimado restante y la barra de progreso 

para cada campo en el que se esté trabajando.
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MÓVIL
1.	 Haga clic en Plan > Work Planner (Plan > Planificador  

de trabajo).
2.	 Seleccione el año y el tipo de trabajo.
3.	 Haga clic en Completed.
4.	 Despliegue el plan de trabajo del que desea ver el progreso.
5.	 Vea el porcentaje completado en Progress.

Consultar el progreso del plan de trabajo
Consulte el progreso del trabajo y el tiempo estimado hasta 
su finalización para los campos con planes de trabajo.

1.	 Haga clic en Plan > Work Planner (Planificar > Planificador 
de trabajo).

2.	 Seleccione el año y el tipo de trabajo.
3.	 Vea el porcentaje completado en Progress (Progreso).
4.	 Consulte el tiempo restante estimado en Time to Complete 

(Tiempo para completar).

NOTA: Si el plan de trabajo supera el 98 % de avance, pasará de "Planned" 
(Planificado) a "Completed" (Completado).
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Analice el rendimiento al final de la temporada para ver cómo 
las decisiones basadas en datos han influido en el rendimiento 
de su actividad. Conocerá la productividad de cada campo y 
variedad, el impacto de diversos insumos en los rendimientos y 
la utilización de cada pieza de equipo. Utilice los datos de este 
año para planificar unos resultados aún mejores para el próximo.

ANALIZAR

Todas las instrucciones de tareas se deben usar 
a través de un navegador web, a menos que se 
indique algo distinto para dispositivos móviles.
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Exportar informes en Work Analyzer  
(Analizador de trabajo)
Generar un informe del trabajo visualizado actualmente, 
incluidos los mapas y los totales resumidos.

1.	 Haga clic en Analyze > Work Analyzer (Analizar > Analizador de 
trabajo).

2.	 Seleccione la actividad, el año y el tipo de cultivo (si corresponde).
3.	 Visualice los datos segmentados por campos, trabajo, variedades, 

equipos u operarios.
4.	 Haga clic en Share/Export > Download Report (Compartir/

Exportar > Descargar informe).
5.	 Seleccione el tipo de informe y formato, y luego haga clic  

en Download Report (Descargar informe).

Analizar el rendimiento del campo y del trabajo 
en toda la operación
Identifique las variedades más productivas para elaborar  
su plan de siembra del año próximo.

1.	 Haga clic en Analyze > Work Analyzer (Analizar > Analizador 
de trabajo).

2.	 Seleccione actividad, año y tipo de cultivo (si corresponde)
3.	 Visualizar los datos segmentados por campos, trabajo, 

variedades, equipo u operarios
4.	 Aplique los filtros deseados para analizar 

Análisis de datos de campo (En Ingles)

MÓVIL
1.	 Haga clic en Analyze y seleccione en la lista de trabajo.
2.	 Haga clic en el ícono Share (Compartir), a continuación 

seleccione PDF o CSV
3.	 Seleccione la herramienta de comunicación (correo electrónico, 

texto, etc.) y envíela al destinatario deseado.

https://www.youtube.com/watch?v=C8r7KcugYYU&list=PL1KGsSJ4CWk6Ie1nD7AytQC1HA-uFF0pl&index=13
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Exportar datos de trabajo en Work Analyzer
Comparta datos de trabajo en bloque con sus asesores  
de confianza.

1.	 Haga clic en Analyze > Work Analyzer.
2.	 Seleccione la actividad, el año, y el tipo de cultivo (si corresponde).
3.	 Haga clic en Share/Export > Work Data (Compartir/Exportar > 

Datos de trabajo).
4.	 Elija la Ubicación de la exportación.
5.	 Seleccione el socio en la lista desplegable (si corresponde).
6.	 Cambie el nombre del archivo si lo desea.
7.	 Haga clic en Export Work Data (Exportar datos de trabajo).

Compartir/Exportar informes en el Field Analyzer
Consulte los totales de trabajo específicos del campo, 
el rendimiento de los equipos y las variedades, así como 
información sobre productos para orientar las decisiones  
para futuras pasadas o la próxima temporada de cultivo.

1.	 Haga clic en Map (Mapa).
2.	 Seleccione el campo y haga clic en Field Analyzer
3.	 Seleccione el año y la capa que desea analizar.
4.	 Haga clic en Share/Export (Compartir/Exportar), luego haga clic  

en Download Report y, a continuación, en Download Report.

MÓVIL
1.	 Haga clic en Analyze, a continuación seleccione el año y la actividad.
2.	 Haga clic en el campo que desea analizar.
3.	 Haga clic en el botón Share (Compartir) y, a continuación, seleccione 

PDF o archivo CSV.
4.	 Seleccione la herramienta de comunicación (correo electrónico, 

texto, etc.) y envíela al destinatario deseado.

NOTA: El analizador de datos exporta datos de trabajo en bloque. Para exportar 
datos de trabajo de campos individuales, utilice el Field Analyzer (Analizador de 
campo) (consulte la página 74).
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Compartir datos de trabajo con una organización 
asociada en el Field Analyzer
Comparta datos de trabajo con asesores de confianza 
asociados para analizar la productividad y el rendimiento.

1.	 Haga clic en Mapa > Field (que desee analizar) > Field Analyzer
2.	 Haga clic en Share/Export > Work Data (Compartir/Exportar > 

Datos de trabajo).
3.	 Haga clic en Share Work Data.
4.	 Seleccione el socio al que va a exportar los datos.
5.	 Haga clic en Share Work Data.

Exportar datos de trabajo en el Field Analyzer
Cree archivos de datos de trabajo para compartirlos con 
asesores de confianza.

1.	 Haga clic en Map > Field (que desee analizar) > Field Analyzer.
2.	 Haga clic en Share/Export > Work Data  

(Compartir/Exportar > Datos de trabajo).
3.	 Haga clic en Export Work Data.
4.	 Seleccione la ubicación de la exportación.
5.	 Seleccione el socio en la lista desplegable (si corresponde).
6.	 Cambie el nombre del archivo si lo desea.
7.	 Haga clic en Export Work Data.
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Analizar el rendimiento parcial del campo con  
la herramienta de zonas seleccionadas
Revise las áreas menos productivas de su campo para ayudar  
a determinar la causa raíz.

1.	 Haga clic en Map > Field (que desee analizar) > Field 
Analyzer.

2.	 Seleccione la actividad (cosecha, siembra, aplicación o 
laboreo) y Capa (rendimiento, productividad, etc) que va a 
analizar.

3.	 Haga clic en la herramienta Selected Zone (Zona seleccionada) 
en la parte derecha del mapa.

4.	 Utilice las herramientas para dibujar alrededor de la zona 
deseada.

5.	 Haga clic en Summary (Resumen) para ver las diferencias del 
área seleccionada en comparación con el resto del campo.

Crear un informe de la máquina
Manténgase al día sobre el rendimiento de la máquina, la 
utilización de la tecnología y el consumo de combustible.

1.	 Haga clic en Analyze > Machine Reports > +Add Report 
(Analizar > Informes de la máquina > +Añadir informe).

2.	 Introduzca el nombre del informe y seleccione el tipo de 
informe y la frecuencia.

3.	 Seleccione si desea recibir un informe por correo electrónico.
4.	 Seleccione el formato del informe.
5.	 Seleccione marca, tipo, modelo y etiqueta (opcional).
6.	 Haga clic en Save.
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Editar datos de trabajo
Modifique los detalles del trabajo (variedad, superficie, 
rendimiento, etc.) para obtener datos en tiempo real que 
permitan un análisis preciso del rendimiento operativo.

1.	 Haga clic en Map > Field (del que desea exportar datos) > 
Field Analyzer.

2.	 Seleccione la capa que desea editar.
3.	 En el cuadro Resumen, haga clic en Edit (Editar) y 

seleccione el detalle de trabajo que desea modificar.
4.	 Realice los cambios necesarios y haga clic en Save.
5.	 Actualice su navegador para ver los cambios.

MÓVIL
1.	 Haga clic en Analyze, luego seleccione el campo que 

desea editar.
2.	 Haga clic en el lápiz y, a continuación, seleccione el 

detalle de trabajo que desea editar.
3.	 Realice los cambios necesarios y haga clic en Confirm 

(Confirmar).
4.	 Haga clic en OK.

Comparar dos capas dentro de un campo
Determine el impacto de una variable sobre otra dentro  
de un campo.

1.	 Haga clic en Map > Field (que desee analizar) >  
Field Analyzer

2.	 Seleccione la primera capa.
3.	 Haga clic en Compare (Comparar).
4.	 Seleccione la segunda capa.
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Revertir ediciones de trabajo manuales
Revierta cualquier cambio a los valores documentados  
por la máquina.

1.	 Haga clic en Map > Field (del que desea exportar datos) >  
Field Analyzer.

2.	 Seleccione la capa que desea revertir.
3.	 En el cuadro Resumen, haga clic en Revert (Revertir) y,  

a continuación, en Revert.

Analizar el equipo a nivel de temporada
Optimice sus equipos en función del uso y el rendimiento  
en comparación con las necesidades operativas.

1.	 Haga clic en Analyze > Work Analyzer
2.	 Seleccione la actividad, el año y el tipo de cultivo  

(si corresponde).
3.	 Seleccione Equipment.
4.	 Utilice el conmutador de totales de trabajo y rendimiento 

para ver los datos de los equipos.
5.	 Seleccione la máquina para ver los campos específicos en los 

que trabajó esa temporada.

NOTA: La opción de revertir solo aparecerá si los datos han sido modificados en el 
Centro de Operaciones.
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Analizar los detalles de la flota
Compare el rendimiento y la utilización de las máquinas en 
toda la flota para identificar a los trabajadores de mayor 
rendimiento, así como las oportunidades de formación.

1.	 Haga clic en Analyze > Machine Analyzer (Analizar > 
Analizador de máquinas).

2.	 Seleccione Performance (Rendimiento) en el menú 
desplegable.

3.	 Seleccione el intervalo de fechas que desea ver.
4.	 Haga clic en la flecha hacia abajo para ampliar la 

categoría de equipos que desea ver.

Uso del analizador de máquinas (En Ingles)

https://www.youtube.com/watch?v=8gNu8bMpKwM&list=PL1KGsSJ4CWk6Ie1nD7AytQC1HA-uFF0pl&index=14
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Cargar datos de documentación manualmente
Cargue los datos recopilados a través de USB en las pantallas 
en cabina de John Deere o de otros fabricantes.

1.	 Asegúrese de que los datos que desea cargar en el Centro de 
Operaciones se descargan en su escritorio o en un USB.

2.	 Descargue Data Manager haciendo clic en ...More > 
John Deere Data Manager > Download (Más > John Deere 
Data Manager > Descargar).

3.	 Siga las instrucciones en pantalla para descargar Data 
Manager a su escritorio.

4.	 Inicie sesión en Data Manager con sus credenciales del 
Centro de Operaciones.

5.	 Seleccione la carpeta deseada en el menú desplegable.
6.	 Seleccione la carpeta en la que se encuentran los archivos 

y haga clic en Select Folder (Seleccionar carpeta).
7.	 Seleccione la organización a la que desea cargar los archivos 

en el menú desplegable .
8.	 Seleccione los archivos que desea cargar y haga clic 

en Upload (Cargar).
9.	 En el Centro de operaciones, haga clic en ...More > Files  

(Más > Archivos para localizar los archivos importados). 
Espere a que diga “File processing finished” (Procesamiento 
de archivos finalizado) en Status (Estado).
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Añadir trabajo finalizado
Registre el trabajo que se completó sin la posibilidad de 
grabar con una pantalla.

MÓVIL
1.	 Haga clic en Home (Inicio), desplácese hasta la parte 

inferior y haga clic en View All Work (Ver todo el trabajo), 
a continuación, haga clic en +.

2.	 Seleccione el campo, el tipo de trabajo, los detalles del 
trabajo, la fecha del trabajo y la hora de inicio.

3.	 Haga clic enSave.
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¡Felicitaciones!
Ya está en camino de comprender el valor de una flota conectada y 
de utilizar los datos para optimizar sus operaciones. Si desea obtener 
más información sobre las herramientas John Deere Precision Ag, visite 
Deere.com o póngase en contacto con su concesionario John Deere 
de confianza.

Si tiene problemas, póngase en contacto con:

Atención al cliente de John Deere

Centro de operaciones Centro de soporte global (en Ingles)

https://isgsupport.deere.com/opscenter-contact-links/
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